uvi "

CAMEQDO

Soundbank Manual

Software Version 1.0
EN 160307

R A R A A A AN N AR N AN A N A N A N AN A AN A A AN AN N A A AN N N A N A A A A A A N A R A A AN AN N A N A AN AN N AN N A A N A N A A R A N A AN A A AN AN A N A A A A A N A v 4
A A A A A A A A A N A N A A A A A A N N A R A A N A A A A A A A A A A A A A A A N A A N A A A A A N A A A A A A A A A N A A A A R A A N A A A N N A A a4

UVI.NET




CAMEO

uvi

oA

End-User License Agreement (EULA]

A A R A A A AN A AR A R A N AN A A AN AN AN AN A A A A N R A A AN AN A A A A AN N A A N A A A A N A A A A A N A N AR A A A A A N A R A N A AN AN A N A N A N A N A N N A A A N 4

Do not use this product until the following license agreement is understood and accepted.
By using this product, or allowing anyone else to do so, you are accepting this agreement.

This End-User License Agreement (EULA) represents the contractual conditions
between you, the Licensee, and UVI, located 159 rue Amelot, 75011 Paris - France
for the use of software, documentation and other materials created by UVI.

You should not register, install or use UVI Products until the
following license agreement is understood and accepted.

By using UVI Products, or allowing anyone else to do
50, you are accepting this agreement.

A- License Grant
1. UVI grants to you, subject to the following terms and conditions, the
non-exclusive right to use each authorized copy of the Product.

2. UVI Product license are granted only to a single user. You
may use this product on up to three separate computers or iLok
Dongles, which shall be owned and used by you exclusively.

3. Renting or lending the licensed Software to a third party is expressly forbidden.

4. Except if otherwise stated within this EULA, Licensee may resell the software

to a third party or transfer the software permanently. Request may be done using
the ‘Transfer License’ feature in your iLok account, subject to a $25 fee per-license
($50 maximum) by Pace. The serial number of the Product will be transferred to
the third party by UVI, and Licensee’s original registration will be deleted.

5. Resale or ownership transfer of individual products obtained in a bundle, or
those used to upgrade or cross-grade to other products are not allowed.

6. UVI allows you to use any of the sounds and samples in the products
you've purchased for commercial recordings without paying any
additional license fees or providing source attribution to UVI.

7. This license expressly forbids resale or other distribution of the sounds and
software included in the Product or their derivatives, either as they exist on disc,
reformatted for use in another digital sampler, or mixed, combined, filtered,
resynthesized or otherwise edited, for use as sounds, multi-sounds, samples,
multi-samples, wavetables, programs or patches in a sampler, microchip or any
hardware or software sample playback device. You cannot sell the Product content
or give it away for use by others in their sampling or sample playback devices.

8. In the event UVI terminates this agreement due to your breach, you agree to
return the original and all other copies of the software and documentation to UVI.

9. UVl reserves all rights not expressly granted to herein.

B- License Activation

1. In order to use UVI Products it is required that you authorize them by
registering your Serial Number on uvi.net/register, have a free iLok account
[not necessarily a dongle) and install the free iLok License Manager (done
automatically by UVI Workstation and Falcon installers). It is impossible

to use UVI Products if they are not registered and authorized.

2. During authorization you will need to enter your name, email address and
postal address which will be stored in the UVI database. UVI uses a secure SSL
connection with 128-bit-encryption that meets current security standards

to transmit your data over the web. For further information about UVI's
handling of personal data please see: https://www.uvi.net/privacy-policy

3. The UVI Product license allows up to 3 simultaneous activations on any
combination of iLok dongles and computers. Activations can be moved
between devices at anytime through the iLok License Manager.

C- Protection of Software

You agree to take all reasonable steps to protect the Product and any accompanying
documentation from unauthorized copying or use. You agree not to modify the
Product to circumvent any method or means adopted or implemented by UVI to
protect against or discourage the unlicensed use or copying of the Product.

D- Ownership

Ownership of, and title to, the enclosed digitally recorded

sounds (including any copies) are held by UVI.

Copies are provided to you only to enable you to exercise your rights under the license.

E-Term

This agreement is effective from the date you open this package, and will remain in
full force until termination. This agreement will terminate if you break any of the terms
or conditions of this agreement. Upon termination you agree to return to UVI all copies
of this product and accompanying documentation and destroy any other copies made.

F- Restrictions

Except as expressly authorized in this agreement, you may not
rent, lease, sub-license, distribute, copy, reproduce, display, modify
or timeshare the enclosed Product or documentation.

G- NFR Serials and Free Products

UVI Products serial numbers labeled as “NFR" (Not For Resale] shall only be
used for demonstration, testing and evaluation purposes. NFR Products may
not be used for commercial purposes, and may not be resold or transferred.
They are not eligible for license recovery and are exempt from update,
upgrade or crossgrade offers, and cannot be purchased with or exchanged for
vouchers. Furthermore, as an owner of an NFR Product, you are not entitled
to promotions available for the commercial version of the Product.

H- No Support Obligation

UVI will make its best effort to support you in the event of technical difficulty with a
UVI Product. However, UVl is not obligated to furnish or make available to you any
additional information, software, technical information, know-how, or support.

1- Specifications and System Requirements

All technical specifications of UVI Products provided are intended to be estimates
or approximations. Due to numerous variables no guarantees of compatibility

or performance can be made. All such specifications shall be in writing.

€nd-User is solely responsible for, prior to purchase, ensuring that End-User's
devices are compatible and meet the system requirements for UVI Products,

and that the applicable UVI Products meet €nd-User’s requirements.

This EULA is governed by the laws of France.

©2017 UVI. All rights reserved.
All trademarks are the property of their respective owners.
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Cameo
Phase Distortion Suite

For us at UVI the CZ series from Casio is a longstanding favorite.
When we approached the Cameo project we wanted to do
something special that not only highlights the amazing sounds
of these classic synths but that offers something new to our
fellow CZ aficionados.

We began with a number of fully-serviced classics, including
the Casio CZ1, CZ101, CZ1000, CZ2300S, CZ3000 and CZ5000,
and ended up with 3 instruments—each with a different
approach, unigue sonic character and inspiration.

CAMEO Cz

Cameo CZ incorporates a huge library of custom patches
designed on the original hardware. An exposition of the
rich diversity of timbres possible through phase distortion
synthesis, sounds range from complex digital tones to thick
and remarkably analog-sounding basses and leads. Cameo CZ
provides an incredibly deep sample library, including variations
with and without the unique Chorus effect of the flagship CZ1.

CAMEO CX
Cameo CX is a dual-layer instrument with a large catalog
of sounds and raw waveforms captured directly from the

hardware instruments. A hybrid methodology implores these
raw waves as the basis for sound design within a modern digital
environment, resulting in a wide variety of tones covering
everything from vintage-inspired to digital bliss. Explore the
factory presets or design your own sounds from scratch with
the raw waveforms.

CAMEO CM

Cameo CM is our own modern inspiration of the phase distortion
sound. Another dual-layer instrument, but this time utilizing
the Wavetable oscillator and DSP shaping tools from Falcon.
Cameo CM isn't sample-based in the sense of the CZ and CX,
rather it's aimed at achieving wholly new and unique sounds
using the capable architecture of the UVI Engine. Explore a
range of high-quality presets or design your own sounds with a
full compliment of synthesis tools and built-in effects.

Whether you're a fan of classic ‘80s synth sounds, a phase
distortion buff, or just looking to expand your palette of go-to
sounds, Cameo delivers a treasure of new and delightful sounds
with the unmistakable character of some of our favorite synths.

Minimum System Requirements

e UVI Workstation 2.6+ or Falcon 1.0.6+

e 92CB of disk space

For more information on the installation process, please refer to
the document: Soundbank Installation Guide
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CAMEO D,S.

Cameo CZ - Edit Page

A A R A A A AN A AR A R A N AN A A AN AN AN AN A A A A N R A A AN AN A A A A AN N A A N A A A A N A A A A A N A N AR A A A A A N A R A N A AN AN A N A N A N A N A N N A A A N 4

CAMEQ G 9 Gt - Pige

& 2 N IRV: PGR: DLV REV: 2 2
e 100% 180% 100% 180% R
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L__PITCH |

e O3

PHASER

REVERB

aFF

AT | | . v J
UNISON OO " ' Modwheel

FILTER

CHORUS

The Ul is divided into two pages; [Edit] and [Mod]. Main controls such as amp, filter, stereo, pitch and effects are available on the [Edit] page. Clicking the
[Mod] button at the top of the interface reveals the second page of controls, where you can access the LFO and Step Modulator. Presets are accessible
directly through the browser in UVI Workstation/Falcon.

1 B Globals + Page Filter cutoff frequency » Tremolo
M 9 » Resonance Speed of the tremolo (sync)
» ono
Dicahl luoh i acti Filter resonance amount »  Filter
isables polyphony if active
A potpRony »  Filter Type Cutoff frequency of the Filter
» I
T P le built-i - Ioff Multimode filter can be set to low-pass
oggle built-in arpeggiator on/o
[a;jtional controlz f\iilable in UVIWS/ (LP), band-pass [BP), or high-pass [HP] > W Effects
» Drive
MF arp page
Edit p page] 3 P Amp Adjust drive value
» I
» ADSR » Phaser
Sets the Ul to the Edit page ) ) }
Mod Typical envelope controls for the amp Adjust effect mix amount
» (1]
» Vel Sens » Dela
Sets the Ul to the Mod page ) ] o ) Y )
Adjust the amp velocity sensistivity Adjust effect mix amount
» Vel > Atk » Reverb
2 P Filter
ADSR Remaps Attack to Note Velocity Adjust effect mix amount
»
Typical envelope controls for the filter .
V”fs ° & B Modwheel 6 B Noise
» Vel Sens
Adjust the fitter velocity sensitivity This section provides a quick way to »  Amount
Deoth map common controls to your MIDI Adjust noise mix amount
» e
5 pth  the filters €6 keyboards modwheel »  White/Pink
epth of the filters
P » Vibrato Select white or pink noise types

»  Cutoff Fre
a Speed of the vibrato (free)
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e @

(e @

OFF
AT
UNISON

CHORUS

7 B Stereo

»  Color
Utilizes neighboring samples from the
library to a unique effect

» Spread
Sets the stereo width (in ALT and UNI
modes only)

» Detune

Detunes the unison layers (UNI mode
only)

»  Mode - Off
Sets the stereo mode to OFF
(monophonic)

»

»

»

IRV: PSR: BLY: REW:
100% 100% 100% 198%

PHASER

REVERB

ARATD

TREMOLO

FILTER

Mode - Alt

Sets the stereo mode to ALT; stereo
position alternates L/R every note, width
controlled by [SPREAD]

Mode - Uni

Sets the stereo mode to UNI; layers
multiple samples and augments them for
increased stereo presence, modify with
[COLOR] and [DETUNE]

Mode - Chorus

Activates hardware Chorus layer

8

»

»

P Pitch

Depth

Sets the depth of portamento [Poly]
Time

Sets the glide time for both modes
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Cameo CZ - Mod Page
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Step Modulator @4

1 PLFO

»  Sync
Toggle LFO sync to host tempo

» Shape
Select the LFO waveform: Sine, Square,
Triangle or Sample & Hold (random)

» Speed
Set the LFO speed
» EG Depth

Set the depth of the LFO envelope
»  Attack

Set the LFO envelope attack time
» Decay

Set the LFO envelope decay time
» > Pitch

Set the pitch modulation amount
» > Drive

Set the drive modulation amount
» > Volume

Set the volume modulation amount
» > Filter

Set the filter modulation amount

»

»

»

»

»

»

»

»

D Step Modulator

Res »
Set the step speed/resolution

Steps

Set the number of steps to playback

Delay

Set the initial delay time »
Rise

Set the time to activate smooth

Smooth

Interpolates sub-step values for a

smooth modulation

> Volume

Set the volume modulation amount

> Filter

Set the filter modulation amount

Step Value

Set the per-step value (draw with mouse,

double-click to enter explicit values)

uvi

oA

P Saving Presets

UVI Workstation

1. Click the [Multimode] button in the
main toolbar

2. Click the [Wrench] icon

3. Select ‘Save Multi’

Falcon

1. Click the [Wrench] icon and save as a

Multi (all parts) or as a Program [single]

Settings for both UVI Workstation and
Falcon will be saved automatically with
your project if you're working within a
DAW.
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Cameo C/Z - Preset List
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Arp: Metallic Sound Reed Tines Pad-Strings: CZ Her Brass
Chords Music Box Short Crystal Keys Cosmopoly 1 Da Brass
CZ World MusiCZ Box 1 Slap Clavinet Cosmopoly 2 Ensemble
Elec Arp One MusiCZ Box 2 So Nineties CZ Choirs Fatanalog
Extreme Kev Old Vibes Soft Pop Organ CZ Hard Pad Fun Brass
Fast Arp Wheel Phase Dist Bells Split Harpsy Express Machine Majestic Brass
Gimme Da Bass Rare Beauty Bell Stack Organ Fast Strings Metronomy 1
Modular Death Steel Drum Tiny Wurli Magic Way Metronomy 2
One Note Mallet Trop Bell Toy Piano Pad Machine Orchestra
Pop Cornus Xylecho Tremellow Keys PD Strings Soft Attack
Saturnox Phase Orchestra TrumpetZ
Space Caroussel FX: Leads: Poly Strings Versoftile
Sweep Arp Big Ben Cosmopolead Solina Z Xpander Brass
The Champion Cosmo Timpani Curtis Z Stack Hato
X Delirium Enigmatic CZ Hard Lead Strings 1 Waveforms:
FX Mallet Dirty Brassy Strings 2 Wave-01
Bass: It is Bomb BB Duck Dance Strings 3 Wave-02
Cosmo Jump Mad Kevin Elastinalog Synth Strings Wave-03
Elec Bass 1 Synth Drums EMW Solo Tron Mello Wave-04
Elec Bass 2 Funky Fresh Voice 1 Wave-05
Filter Wheeling Keys: Fuzz Mosquito 1 Voice 2 Wave-06
Fretless Watch Barbarie Fuzz Mosquito 2 Wave-07
Fuzz Wheel Bass Cosmo Harpsichord Critty Five Polysynth: \Wave-08
ImaginaCzion 1 CzP Piano Larsenor Mittal Cosmophonic Wave-09
ImaginaCzion 2 Dark CZ Keys LLead Her Brass Doctor Phase Wave-10
More than Analog Deluxe Clav Like a Bird Driver Wave-11
Organ Bass Dynosauroad Nanolead Eighties Pluckeys Wave-12
Phat CZ Analog Funky Clavi 1 Patchoulead Factor Hard Wave-13
Plastic Bass Funky Clavi 2 Perc Whistle Funky Stab Wave-14
Reso Bass Grand CZ Picolead Gritty Poly Wave-15
Saturn Bass Harpsichord Plastic Solo Love Poly Wave-16
Slap Bass Honky Tonk Chorus Smooth Pop Plastic Pluck Wave-17
Super Phase Hybrid Wurlicoustic Steady Solo Poly Funky Wave-18
Synth Chorus Bass HybriDream 1 Synth Lead 1 Poly Tanger Wave-19
Whale Siren HybriDream 2 Synth Lead 2 PolyMagination Wave-20
Impressive Road 1 Synth Lead 3 Short Five Wave-21
Bells-Mallet: Impressive Road 2 Synth Saxo Short Pluck Wave-22
Afro Perc 1 Jazz Organ Take Five Soft Pluck Wave-23
Afro Perc 2 Keys Brid Whistle Square Keys Wave-24
Balaphonic 1 LA Chapelle 1 Stab Five Wave-25
Balaphonic 2 LA Chapelle 2 Misc: Wavetabling Wave-26
Balaphonic 3 LA Chapelle Acc Cuitar Wave-27
Bellisimax Large Chorused Almost Harp Sweeps: Wave-28
Bells Lounge Electric CZ Trumpet CZweep Classic \Wave-29
Carillon Magikeys Flute Sweep Sound 1 Wave-30
Conga Mellow Phase Keuys Harp Sweep Sound 2 Wave-31
Cosmo Bells Old Organ Hybrid Fretted Ultra Sweep Wave-32
CZ Fantasia 1 On the Road again Jazz Guitar Wave-33
CZ Fantasia 2 Organ Attack Koto Synth Brass:
Drop Pop Phase Clave Medieval Picollo Analog Pure
FX Bells Piano 1 Orchestral Flutes Attitude
Gloken Piano 2 Sitar Long Bend Brass 1
Hybrid Christmass Piano Compact 1 Slap Funk Brass 2
Like a Bell Piano Compact 2 StatoCZphere 1 Brass 3
Mallet Log Pipe Organ StatoCZphere 2 BrasSquare
Marie Pad Bell Pluckeyboard StatoCZphere 3 Chill Brass
Marimba Pure Tines Steevy Cosmo Cosmobhie One
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CAMEO D,S.

Cameo CX - Edit Page
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T e CANMED _ > )
PRESET LAYER VL AAM
Layer Globas| @@}

Y8 Amplitude

Layer Edit @]
s TN

» I

VIBRATO  AMOUNT TREMOLD  AMOUNT FILTER AMDUNT

The Ul is divided into three pages; [Edit], [Mod] and [Arp]. Primary controls such as amp, filter, stereo, pitch and effects are available on the [Edit] page.
Clicking the [Mod] button at the top of the interface reveals the second page of controls containing the LFO and Step Modulator. The final [Arp] page
presents an independent arpeggiator for each layer.

Main Basic Controls .
7 P Amplitude
. » ADSR
1 P Presets 5 B Layer Edit _
Attack / Decay / Sustain / Release
Select a global preset from the pull- » Wave Menu ) ]
) ) ) envelope for the Amplitude section
down menu or browse them with the Choose the wave category in the first row i
i » Velocity > Attack
Prev/Next arrows and the wave in the second
) . X Modulates attack amount based on
» Edit 1| Edit 2 | Edit All , ) , -
i incoming note velocity. Low velocities
2 B Pages Choose to edit layers A or B seperately or ) ‘ -
) i result in long attacks; high velocities
Change the current page by selecting simultaneously ,
) ] result in short attacks.
one of the 3 options; €dit, Mod or Arp Velocit
. » Veloci
6 B Pitch Set H‘J" [ tes t locit
ets all incoming notes to max veloci
3 P Layer Globals » Octave o J
» On/Off Toggle Adjust the pitch in Octaves .
99 ) . . 8 P Drive
Turn layers A and B on or off »  Semi 3
) o ) »  On/Off Switch
» Volume Adjust the pitch in Semitones
] »  Amount
Adjust the Volume of each layer » Depth )
) Sets the amount of drive
» Pan Adjust the Portamento depth
Adjust the Pan of each layer » Time
Set the Clide time
4 B Master Gain » Mono
Set the Output Gain for the instrument Toggle between Mono and Poly voicing
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Cameo CX - Edit Page
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Global Preset Name

PRESET

10

( sew @
D e )

VIBRATO  AMCUNT TREMOLD  AMOUNT FILTER AMOUNT Y3 Modwheel

Basic Controls {continued] 10 B Filter 11 D Effects
» ADSR » Power/Amount
9 P Stereo Attack / Decay / Sustain / Release Choose from Phaser, Delay, Reverb and
» Mode envelope for the Filter section Chorus (additional controls available in
Off / Alternate Pan / Unison »  Cutoff the Effects page of UVIWS and Falcon)
» Color Filter cutoff frequency
Shifts color based on adjacent samples » Resonance 12 » Modwheel
» Spread Adjust the resonance (Q) of the Filter » Power/Amount
Change the stereo width » EG Depth Easily route your controllers Modwheel
» Detune Modifies the amount of ADSR envelope to control common parameters such as
UNI Mode Only: setunes layers to be applied to the Filter Vibrato, Tremolo and Filter Depth
» Velocity

Adjust the Velocity > Filter sensistivity
»  Type

Choose Filter mode; High Pass, Band

Pass, or Low Pass
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Cameo CX - Mod Page

A A R A A A AN A AR A R A N AN A A AN AN AN AN A A A A N R A A AN AN A A A A AN N A A N A A A A N A A A A A N A N AR A A A A A N A R A N A AN AN A N A N A N A N A N N A A A N 4

CAMED (_“315;3 i Global Preset Name

PRESET

D rooms )

FILTER

Step Sequencer @ ¥ Mod Routing

LFO Controls @]

FILTER VOLUME

LAYER A | | LAYER A

LAYERD | | LAYER D

. » Dela
LFO & P Mod Routing v o
) Delay time to activate first step
Control the amounts of LFO modulation i
» Rise
1 B Sync to be applied to various parameters _ _ _
] ) ) } } ) Time to activate step with a smooth
Enable/Disable LFO sync to Host Tempo including; Pitch, Drive, Volume and Filter B
transition
» Smooth
2 P Waveforms
Step Modulator Interpolates values between adjacent

Choose LFO waveform; Sine, Triangle, )
steps to smooth parameter modulation
Square or Sample & Hold

5 B Step Sequencer for a custom LFO effect
Interactive editor for programmin
3 B LFO Controls , oo . ’ ;
Speed sequenced modulations; bar height 7 P Mod Routing
» ee
P equals mod amount Control the amounts of modulation to be
Change the LFO Speed ) : : )
applied to various parameters including;
» Depth )
_ 6 B Params Volume and Filter
Adjusts the amount of Attack and Decay Grid
»  Gri

to be applied to the LFO
»  Attack
Attack time for the Speed envelope

Change the sequencers step length
» Steps

Change the amount of steps for the
» Decay

) sequencer to play
Decay time for the Speed envelope
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CAMEO

Cameo CX - Arp Page
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CAMEQ CGX

Step Indicator @k
Step Editor @4

Layer A > Layer B {3

1 P Step Indicator
LED lights up when step is triggered

2 B Step Editor

16-step sequencer; affects Velocity

3 P Tie
When active, step inherets Velocity from

the previous step

4 P Layer1l>Layer?2
When active, Arpeggiator 1 affects
both layer A and layer B (whereas
when disabled each Arp modifies its
corresponding layer only)

| Glebal Preset Name

PRESET AT e le = i 5

(B Steps

-3 Gate

8 Rate

Y& Mode

40y Octave

» Arp On/Off
Toggle the Arpeggiator On/Off

10 B Octave

in Octaves
D Steps
Change the step length

P Mode
Select Up, Down, or Up and Down

D Gate

Change the step length [knob value
ranges from zero to the tracks Resolution
setting)

P Rate
Sets the Arpeggiators step length
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Arp On/Off

Set the pitch range of the Arpeggiator
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CATEGORY
00-Init
AR-Analog CZ
AR-Bass to Arp
AR-Fantasiarp
AR-Colden Age

BR-Peggio
BR-Poly Solo
BR-Simple One
BR-Stack Brass
BR-Wheel Morph
BS-Co Jones

LD-No Clide

LD-P Funk CZ
LD-Phase Pop Corn
LD-Scie Digitale
LD-Sheet Corea
LD-Simple Lead

ST-Le Grand Blue
ST-Orchestral Phase
ST-Solinox
ST-Stack Strings
ST-TV Show 80s
ST-War After

AR-Magician BS-Da Cosmos LD-Solo Raw SW-CGonzasweep
AR-Muystic Lounge BS-Eighties Pattern LD-Space Flute SW-0n Wheel
AR-Pad Arp J BS-Hendrix Sub LD-Toxicosmos SW-PortamentHigh
AR-Plastic Age BS-Log A Rythm LD-Wheel Xpression SW-Scary
AR-Pluck and Soft BS-Orchestral Big PD-Air France SW-So Classic Z
AR-Ritournelle BS-Raw Beef PD-Analog Vision SW-Template
AR-Sonic Village BS-Skriwheel PD-Baurealis

AR-Tangerine Wheel BS-Sub Whale PD-Broken Pad

AR-Time Backup BS-Supra Funk PD-Cosmo Pad

AR-Vox Portal BS-Wha Sub PD-Crystal Lounge

AR-Wheel Berimbau CH-Forest Calm PD-Dreaming

AR-World Box CH-Joly J PD-FX Pad

BL-Bell Friend CH-Light Step PD-GClass of Star

BL-Christ Mess CH-Matador PD-Horse Wheel

BL-Cosmo Koto CH-Mayhem Control PD-Melocoton

BL-Expression CH-Reggae Tone PD-New Agent

BL-Gimmick CH-Road Movie PD-Polaire

BL-Horizone CH-Slow Motion 1 PD-Smoothie

BL-Hybrid Case CH-Slow Motion 2 PD-Superbe

BL-Interfered CH-Top Hard Wheel 1 PD-Under Terra

BL-Log Mall CH-Top Hard Wheel 2 PD-Wheel Manipulation

BL-Mallet Hit B CH-Under Control PD-Zen Bell

BL-Meditation KB-Big CZ Keys PL-Cosmo Delirium

BL-Mixed Bells 1 KB-CameOrgan PL-Crazy Poly Wheely

BL-Mixed Bells 2 KB-De Barbarie PL-Dirty Diana

BL-0ld Field KB-Eight Bit PL-Drop Box

BL-Papillon KB-FunkHybrid PL-Empire Strat

BL-Plastic Bell KB-Lunharpsichord PL-Equation

BL-Rome Antigque KB-Marimkeys PL-Intense City

BL-Space Class KB-One More Time PL-Magical Flute

BL-Toy Qisac KB-Pure Tines PL-Poly Tess

BL-Ultra Wet KB-Sweep and Chips PL-Saw Wheel

BR-BasiCZ KB-The Fifth Organ PL-Synth Pole

BR-Brasstring KB-Wave Keys PL-Tosca Link

BR-Cindy Looper KB-Wheel Fantasia PL-Weirdome

BR-Digital Orchestra LD-Dualead PL-Yanni Chord €

BR-Massive Brass LD-Funkadelead ST-Cameo Strings

BR-Mosquito Brass L D-Guitarinx ST-Cosmotron
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Cameo CM - Edit Page
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1 vosercan )

Presets (@8

Layer Globals @}

Amplitude @

(" prase Dstorton i ' e

min

SPRZAD  DETUME . AMOUNT

Main Section Basic Controls 7 P Amplitude
» ADSR
1 P Presets 5 P Edit Attack / Decay / Sustain / Release
Select a global preset from the pull- » A|B|AB envelope for the Amplitude section
down menu or browse them with the Choose to edit layers A or B seperately or » Velocity
Prev/Next arrows simultaneously Sets all incoming notes to max velocity
» Wave Menu » Velocity > Attack
2 B Pages Choose a waveform Modulates attack amount based on
Change the current page by selecting incoming note velocity. Low velocities
one of the 3 options; Edit, FX or Mod 6 P Pitch result in long attacks; high velocities
»  Semi result in short attacks.
3 P Layer Globals Adjust the pitch in Semitoness
»  On/Off Toggle » Depth 8 P Phase Distortion
Turn layers A and B on or off Adjust the Portamento depth Change the amount of phase distortion
» Volume » Mono

Adjust the Volume of each layer

Toggle between Mono and Poly voicing

» Pan » Time
Adjust the Pan of each layer Set the Clide time
» Octave

4 P Master Gain
Set the Output Gain for the instrument

Adjust the pitch in Octaves

A AR AN A A A N AN N A A N A R A A AR A A AN AN AN AR N AN A A A N A N N N A N A A N A R A A AN N AN AR A R AN A N AN N A AN N A N A A AR A N A A A A A A N A A a4 1[_|_
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10 I

i

]

¥ Modwheel

SPRZAD  DETUME . AMOUNT

Basic Controls {continued] 10 B Filter 11 » Modwheel
» Mode » Power/Amount
9 P Stereo Choose Filter mode; Off, Low Pass, Band €asily route your controllers Modwheel
» Unison Voices Pass, or High Pass to control common parameters such as
Change the number of unison voices »  Cutoff Vibrato, Tremolo and Filter Depth
» Spread Filter cutoff frequency
Change the stereo width » Resonance
» Detune Adjust the resonance (Q) of the Filter
UNI Mode Only: detunes voices » Offset
» Alt Adjust the amount of frequency offset
Alternate pan mode » Drive

Adjust the amount of drive
» Depth
Modifies the amount of ADSR envelope
to be applied to the Filter
» Velocity
Adjust the Velocity > Filter sensistivity
» ADSR
Attack / Decay / Sustain / Release
envelope for the Filter section
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Cameo CM - FX Page
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(oo @

o €

(e @

1 ® Chorus 2 B Phaser 4 B Reverb
» On/ Off » On/ Off » On/ Off
» Filter » Speed » Size
Adjust the filter frequency Adjust the phasers LFO speed Adjust the room size
» Dry » Feedback » Time
Adjust the dry signal amount Adjust the phasers feedback amount Adjust the decay time
»  Wet » Depth » Lo
Adjust the wet signal amount Adjust the phasers filter depth Adjust the low freq decay multiplier
» Hi
3 P Delay Adjust the hi freq decay multiplier
» On/ Off »  Mix
» Time Adjust the effect mix amount

»

»

Adjust the delay time

Feedback

Adjust the delay feedback amount
Mix

Adjust the effect mix amount

A AR AN A A A N AN N A A N A R A A AR A A AN AN AN AR N AN A A A N A N N N A N A A N A R A A AN N AN AR A R AN A N AN N A AN N A N A A AR A N A A A A A A N A A a4



http://www.uvi.net/

CAM

=0

Cameo CM - Mod Page
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Step Sequencer @

LFO Controls @]
( viaverorms @

uvi

oA

D rooms )

¥ Mod Routing

—

VOLUME

FILTER

= =m

L% Mod Routing

PITCH

. » Dela
LFO & P Mod Routing v o
) Delay time to activate first step
Control the amounts of LFO modulation i
» Rise
1 B Sync to be applied to various parameters _ _ _
] ) ) } } ) Time to activate step with a smooth
Enable/Disable LFO sync to Host Tempo including; Pitch, Drive, Volume and Filter B
transition
» Smooth
2 P Waveforms
) ) Step Modulator Interpolates values between adjacent
Choose LFO waveform; Sine, Triangle, )
steps to smooth parameter modulation
Square or Sample & Hold
5 B Step Sequencer for a custom LFO effect
Interactive editor for programmin
3 B LFO Controls , pros : 0 .
Speed sequenced modulations; bar height 7 P Mod Routing
» ee
P equals mod amount Control the amounts of modulation to be
Change the LFO Speed ) ) i )
applied to various parameters including;
» Depth )
_ 6 B Params Volume and Filter
Adjusts the amount of Attack and Decay Rat
» ate

to be applied to the LFO

Attack

Attack time for the Speed envelope
Decay

Decay time for the Speed envelope

»

Change the sequencers step length
Steps
Change the amount of steps for the

sequencer to play
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CATEGORY
00-Init
BL-Emphasis
BL-Mario Square
BL-Mixity
BL-Model Bell
BL-Simple Beauty
BL-Standard Bell
BL-Synth Bell
BL-Vick Celesta
BR-Los Vangelis
BS-A Big one
BS-Grainy Subby
BS-Larsen Wheel
BS-Offset Funk
BS-Phat Clic
BS-Raw Saw 1
BS-Raw Saw 2
BS-Sub Wobble Wheel
BS-Wheel Me Step
BS-Zapp Sub
FX-Cyber Dolfin
FX-Heroes
FX-Sonar Space
FX-Sub Liminal
FX-The Wizzard
FX-War Star
KB-Claviwheel
KB-CreatiWet
KB-Ethereal Keys
KB-Halorgan
KB-Keycoustic
KB-Kooba Kooba
KB-Like a Bell
KB-Step a Toy
LD-A Level
LD-Change Da Wave
LD-Dirty One
LD-Dream Land
LD-Fuzz Wheel
LD-LaCie Musicale
LD-Mamouth
LD-Pepo Nekor
LD-Simplead
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L.D-Solo Podo
LD-White Street
PD-Dark Angel
PD-Dirty One
PD-Dirty Wheel
PD-Evolute
PD-Heroine
PD-Octave Strings
PD-Ominous Digital
PD-0Ominous Vox
PD-Partamentos
PD-Revolution
PD-Soli Paddi
PD-StePad
PD-Tremooloo
PL-Basic Poly
PL-Double Stack
PL-Fairlight Vibe
PL-Centle Pluck
PL-Helicopwheel
PL-Hive and Cesar
PL-I Am Mod
PL-LFO Rice On
PL-Majestic Pluck
PL-Mishok Wheel
PL-Moore Uzi
PL-Pizzi Catho
PL-Pure Madness
PL-Short Stab
PL-Skritonium
PL-Step Filter Wheel
PL-Step Folie
ST-Analog Strings
SW-Allin Camon
SW-Astral Risk
SW-Big Sweep
SW-Long Island
SW-Simple Sweep HP
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UV

Home . . o uvi.net/ &

Soundbank Installation Guide . . . . . . .. ... installing_uvi_soundbanks_en.pdf &
UVI Workstation User Guide . . . . . . . . . ... uviworkstation_user_guide_en.pdf &
Your Registered Product Serial Numbers and Download Links. . . . . .. .. uvi.net/my-products &

FAQ . uvinet/fag &

Tutorialand Demo Videos . . . . . . . . .. youtube.com/&&

SUPPOrt . . . uvi.net/contact-support &

iLok

Home . . o ilok.com/ &

iLok License Manager . . . . . ... ilok.com/ilm.html &

FAQ . ilok.com/supportfag &

VDI 100000100 0000000 00000000000 000000000000000000000000000000002000007220002 19

UVI.NET



http://www.uvi.net/
http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.ilok.com/
https://www.ilok.com/ilm.html
https://www.ilok.com/#!faq

/AWM E(O)

Credits and Thanks

Produced by UVI

Recording / Editing / Sound Design
Damien Vallet
Kevin Guilhaumou
Alain J Etchart

Software + Scripting
Olivier Tristan
Remy Muller

GUI, Design

Nathaniel Reeves

Documents
NEIGERIENNEEES
Kai Tomita

uVvi o

e

UVI.NET




	EULA
	Table of Contents
	Introduction
	CZ
	Edit Page
	Mod Page
	Preset List

	CX
	Edit Page
	Mod Page
	Arp Page
	Preset List

	CM
	Edit Page
	FX Page
	Mod Page
	Preset List

	Links
	Credits and Thanks

